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WARRANTY

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on the
media will be free from defects in materials and workmanship for a period of three (3) months from the date of shipment.
If a medium or encoding proves defective during the warranty period, Tektronix will provide a replacement in exchange
for the defective medium. Except as to the media on which this software product is furnished, this software product is
provided “as is” without warranty of any kind, either express or implied. Tektronix does not warrant that the functions
contained in this software product will meet Customer’s requirements or that the operation of the programs will be
uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the
warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and workmanship
within a reasonable time thereafter, Customer may terminate the license for this software product and return this software
product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR
IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX' RESPONSIBILITY TO
REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE
REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY. TEKTRONIX AND ITS
VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF
THE POSSIBILITY OF SUCH DAMAGES.
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Preface

This manual describes how to use the Tektronix MPEG Program Stream
Analyzer application. Using the MPEG Program Stream Analyzer, you can view
the fields and values of MPEG2 program streams and MPEGL1 system streams at
the pack and PES packet level, extract and save all or part of program and
system streams, and analyze streams for coherence to the MPEG standards.

The MPEG Program Stream Analyzer is part of the MTS 300 suite of hardware
and software components used to create, generate, acquire, and analyze MPEG
and DVB transport and program streams and can be used by itself or as an
integral part of the MPEG test system. If you have the Elementary Stream
Analyzers installed on your system, you can send video or audio elementary
streams directly to the appropriate analyzer for analysis at the elementary stream
level.

For information about other MTS 300 test system applications, refer tséne
manualsgprovided with test system or software option. For information about
MTS 300 test system hardware installation, specifications, and first-time
operation, refer to theITS 300 PEG Test System Hardware and Software
Installation Technical Referenc&ektronix part number 071-0667-XX.

For information about the Windows NT Workstation operating system, refer to
the Microsoft documentation that accompanied your test system.

Table i lists the MTS300 MPEG Test System application version supported by
this manual. To verify an application version number, séletp in the
application menu bar; then selédiout from the Help menu.

Table i: MTS300 MPEG Test System (V5.0) supported applications

Application Supported version
MPEG Program Stream Analyzer V1.04 and above

MTS300 Series Program Stream Analyzer v

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Preface

Contacting Tektronix

Product For questions about using Tektronix measurement products, call
Support toll free in North America:

1-800-833-9200

6:00 a.m. — 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tek.com

For product support outside of North America, contact your
local Tektronix distributor or sales office.

Service Tektronix offers a range of services, including Extended
support Warranty Repair and Calibration services. Contact your local
Tektronix distributor or sales office for details.

For a listing of worldwide service centers, visit our web site.

Toll-free In North America:
Number 1-800-833-9200
An operator can direct your call.

Postal Tektronix, Inc.
Address Department or name (if known)
P.O. Box 500
Beaverton, OR 97077
USA
Web site www.tektronix.com
vi MTS300 Series Program Stream Analyzer
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Getting Started

Product Description

The MPEG Program Stream Analyzer is used to view and analyze MPEG1 and
MPEG2 program stream structures, fields, and values. This section lists the
various views and analysis functions enabled by the MPEG Program Stream
Analyzer and describes how to find the information you need to install and use
your analyzer the first time.

You can display graphical representations of the MPEG structures of a program
stream using interactive view windows, called interpreted views. Interpreted
views are used to display the following MPEG program stream structures:

Pack header

PES packets
®  Program stream map (PSM)
m  Program stream directory (PSD)

In addition to the interpreted views, the analyzer provides other ways of viewing
MPEG structures and values:

®m  Hierarchic view

m  Hexadecimal and binary views

m  System clock reference (SCR) views

®  Presentation time stamp/Decoding time stamp (PTS/DTS) views

You can analyze syntactic, semantic, and temporal (time-based) characteristics
of a program stream using the analysis functions provided by the analyzer. The
analysis functions provided are indicated in the following list:

®  Multiplex rate analysis

®m  Syntactic analysis

®  Consistency analysis (coherence between all components of the stream)
m  System clock reference (SCR) analysis

m  Presentation/Decoding time stamp (PTS/DTS) analysis

MTS300 Series Program Stream Analyzer 1-1
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Getting Started

First Time Operation

1-2

Using the MPEG Program Stream Analyzer you can also extract individual
elementary streams for analysis later. Alternatively if you have the Tektronix
MPEG Audio Stream Analyzer and/or MPEG Video Stream Analyzer installed
on your system, you can extract an elementary stream and display a graphical
representation of it using one of the elementary stream analyzers automatically.

The MPEG Program Stream Analyzer is part of a suite of hardware and software
components used to create, generate, acquire, and analyze MPEG and DVB
transport and program streams. Before you can use the analyzer, you need to
ensure that you have entered the correct password for your software configura-
tion. To enable the software you have purchased, use the procedure for entering
the general password described inNMiES300 Series Software Only Installation
Instructions Tektronix part number 075-0630-XX.

MTS300 Series Program Stream Analyzer
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Operating Basics

This chapter provides a functional overview of the MPEG Program Stream
Analyzer interface elements and provides basic operating procedures that will
help you become familiar with the application. This chapter is organized into the
following sections:

NOTE. For basic Windows operating techniques such as minimizing windows or
using the scroll bars, refer to your Windows documentation.

m  Functional Overvievshows you how to start the MPEG Program Stream
Analyzer and describes user interface elements and characteristics of the
windows used by the analyzer.

m  MPEG Program Stream Analyzer Viedsscribes the Hierarchic view and
the common characteristics of Interpreted views.

m  Basic Operationslescribes how to open, extract, and save program or
system stream files; how to print data encoded in the active file; and how to
exit the application.

®  Menu Selectionprovides a table that summarizes the menu selections.

MTS300 Series Program Stream Analyzer 2-1
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Operating Basics

Functional Overview
Double click the MPEG Program Stream Analyzer icon in the MPEG Test

System program group window.
s
i S The MPEG Program Stream Analyzer uses two types of windows to display the

elements of a program stream: the application window and view windows. This
sectiondescribes these window types. (See your Windows documentation for
information about common Windows display elements.)

Application Window  The basic application window looks similar to the following illustration.

1 [=] B3

Title bar — " Program Stream Analyzer
Menu bar ———  File Edit View Analpsiz Options “Window Help

Upper toolbar —— = ¢B|=3) |

" Hierarchic View of Default. pck

Application
window
Pes 192
. . 1Mo001
.V'eW Pes190 DATA
window

Edit toolbar — m i| ll _}lm ﬂl

Statusbar — | |

Title bar. The title bar displays the application name and application icon. The
window control buttons are standard window controls and allow you to
minimize, maximize, and close the application window.

2-2 MTS300 Series Program Stream Analyzer
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Operating Basics

Menu bar. The menu bar provides access to the commands you use to control the
display, analysis, and look of the MPEG Program Stream Analyzer. A list of
menu selections is provided Menu Selectionbeginning on page 2—18.

Complete descriptions of each menu selection are provided @pti@ns Menu
Referencesection beginning on page 3-19.

Upper toolbar. The Upper toolbar provides shortcut buttons to five commonly
used menu selections. These buttons, and the menu selection they represent, are
described in Table 2-1.

Table 2-1: Upper toolbar buttons

Name/Menu
Button | selection Menu This selection...

£_E| Open File Displays the Open dialog box. See Opening Program
Stream Files beginning on page 2-11.

B Save as File Displays the Save As dialog box. See Extracting and
Saving Program Streams beginning on page 2-12.

!l Add View Window | Displays a submenu from which you specify a view to be
displayed. See Adding Views beginning on page 3-6.

Edit toolbar. Selecting an Edit toolbar command button is identical to selecting
the Edit menu selection of the same name. These buttons, described in

Table 2—2, allow you to move through the items of the displayed element and to
view errors in the program stream file.

Table 2-2: Edit toolbar buttons

Button Name

This selection/button...

First ltem

Displays the first item in the active view.

Previous ltem

Displays the previous item in the active view.

[l =

Displays a dialog box that allows you to select the item number
of the active view you want displayed.

Displays the next item in the active view.

Goto
_)| Next ltem
ﬂl Last Item

Displays the last item in the active view.

Number of ltems

o
FY

Counts the number of items in the element and displays the
number in the top line of the view window.

Next error

%

Displays the next item that has an error in the program stream
file.

MTS300 Series Program Stream Analyzer
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View Windows

NOTE. ltemsare instances of specific data types, or elements. The first instance
of the program_stream_map() element in the bitstream is the first item displayed
in the PSM interpreted view.

Status bar. The Status bar, located just below the Edit toolbar, provides you with
first level help on using the menus. As you highlight a menu item, the status bar
briefly describes the selection.

View windows are used to display program stream files at different levels. Most
of the important information displayed in view windows is discussed in the
discussions of the individual view windows elsewhere in this manual. However,
in addition to standard window controls, the title bar and top line of most view
windows have the following information types in common:

File name  Viewtype  Item number Position

= Pan Viow of Dofaulopck L |
Program Streatn Ilap Ttera 1 - Position : 14703 byrtes il

| packet start | | Hap | |progmm strea.m| |cun'ent nex‘t| |resen-'ed| |progra.m strearn | |reserved| |progra.m strea.m| el

m  File name. Indicates the file name of the view displayed.

® View type. The view type indicates the program stream element displayed.
For instance, pack_header() and PES_packet() data represent Pack header
and PES packet elements respectively

® [tem number. Indicates the item number of the element displayed. If you
have previously selected the last item, or have selected the Number of Items
command button, the item number is followed by the total number of items
for the displayed element in the bitstream.

m  Position. Indicates the position (in bytes) of the first bit of information
displayed in the interpreted view relative to the first bit of the program
stream. The first bit of the program stream is zero.

MTS300 Series Program Stream Analyzer
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MPEG Program Stream Analyzer Views

You can use the MPEG Program Stream Analyzer to view the program stream
and program stream elements at different levels. This section briefly describes
the three basic views (hierarchic, interpreted, and binary and hexadecimal views)
and how to access them. Seterpreted Viewdeginning on page 3-1, and see
Additional Viewsheginning on page 3—6 for more detailed information about the
various view types used by the analyzer.

Hierarchic View  The Hierarchic view window displays a graphical view of the overall structure of
the program stream indicated in the title bar of the active view window. The
Hierarchic view is displayed when you first open an program stream file as a
stream file type. Se@pening Program Stream Files page 2—-11 for more
information on opening different file types.

"1 Hierarchic View of Default.pck

[T
mSﬂm
oo

DATA

1] | M 4

The icons displayed show the logical structure of the active program stream,
provide access to various interpreted view and analysis functions, and allow you
to save the elementary stream data to a file. These icons, and the interpreted
views they access, are shown in Table 2—-3 on page 2—6.

Icons with a red “X” on top of them indicate stream elements that are referenced
in the PS map or PS directory, yet are not present in the bitstream. Icons with a
red “?” on top of them indicate stream elements that are found in the bitstream,

yet are not referenced in the program stream map (ghost elements).

MTS300 Series Program Stream Analyzer 2-5
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Table 2-3: Hierarchic view icons

Icon |Name | Double click the The interpreted view Right-clicking the icon
icon to display displays will also allow you to
PS Pack header Fields associated with the | Perform Rate or SCR
interpreted view pack_header () and analyses, or display a
(page 3-2) system_header() packet map of all the
elements of program packets in the program
streams. stream.
Pack | Pack header Fields found in the Perform Rate or SCR
interpreted view pack_header () and analyses, or display a
(page 3-2) system_header() packet map of the packets
elements of program in the program stream.
streams.
PSM Program stream Fields associated with the
map interpreted program_stream_map()
view element of program
(page 3-4) streams.
PSD Program stream Fields associated with the
directory interpreted | directory PES_packet()
view element of program
(page 3-5) streams.
PES PES packet Fields associated with the | Perform PTS/DTS anal-
interpreted view PES_packet() element of | yses on the selected
(page 3-3) program streams. program stream item.
F:4 | VIDEO | Save Video Stream Analyze the video stream
. dialog box using the MTS Video
(page 2-16) Stream Analyzer, provided

you have the Elementary
Stream Analyzer installed
on your system.

AUDIO

Save Audio Stream
dialog box
(page 2-16)

Analyze the audio stream
using the MTS Audio
Stream Analyzer, provided
you have the Elementary
Stream Analyzer installed

on your system.
ooaol | DATA | Save Data Stream
1110001 d|a|0g bOX
(page 2-16)
24l | End End Code message
& Code | window

MTS300 Series Program Stream Analyzer
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Interpreted View Windows  You can display the values encoded in program stream structures using interac-
tive view windows, called interpreted views. The interpreted views enabled by
the MPEG Program Stream Analyzer and some of the fields and values
displayed in each view are indicated in the following list:

m  Pack header. The Pack header interpreted view displays SCR, multiplex rate,
audio and video bounds, and target decoder fields and values.

B Program stream map. The PSM interpreted view displays PSM header,
elementary stream ID, and CRC fields and values.

m  Program stream directory. The PSD interpreted view displays PSD header,
PES position offset, and access unit PTS fields and values.

m  PES packets. The PES packet interpreted view displays PES packet header,
scrambling, and PTS/DTS fields and values.

Access interpreted views by double-clicking the icons displayed in the Hierar-
chic view. See Table 2—3 on page 2—6. Page references in the table indicate
where you can find more information about the specific interpreted view.

The following sections describe the interface elements and interactive character-
istics common to all interpreted views and how to navigate through the items of
program stream elements.

Interface elements. Each interpreted view window displays the following types of
information:

m  File name. The file name indicates the name of the program stream file
displayed.

m  View type. The view type indicates the program stream element displayed
(for instance, pack_header() and PES_packet() data represent Pack header
and PES packet elements respectively).

File name  Viewtype Itemnumber Position

packet start map | [program strearn| |curtent newt | [reserved| | program streamn | |reserved| [program strear) | el
str

code prefix | |streamid | | map length indicator AR VErsion info length
[ Jles [ s Q[+ 2 ][5 Q@ ][ of [
2 —I1f — ] — D —— " p—— — ] —— | —— —
stream | | elementary | | elementary
type stream id stream info
Field length or Value Field
position indicator rectangle rectangle
MTS300 Series Program Stream Analyzer 2-7
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2-8

Item number. Indicates the item number of the element being displayed. (See
page 2—4 for the definition of arem.) If you have previously selected the

last item, or have selected the Number of Itesramand button, the item
number is followed by the total number of items for the displayed element in
the bitstream.

Position. Indicates the position (in bytes) of the first bit of information
displayed in the interpreted view relative to the first bit of the program
stream. The first bit of the program stream is zero.

Field rectangle. Indicates the name of the field displayed. See the description
for Field rectangles in the following sectidnteractive characteristics

Value rectangle. Indicates the value for the field named in the Field rectangle
immediately above it. See the description for Value rectangles in the
following section nteractive characteristics

Field length or position indicator. Indicates the position in the bitstream of
the field immediately above it relative to the first bit in the current item. The
first bit of the current item is zero. You determine which type of information,
if any, is displayed using the Interpretation selection from the Options menu.

Interactive characteristics. Interpreted views display selected fields and values of
MPEG1 and MPEG2 encoded program streams. The fields and values displayed
for any given item in the program stream are represented by the field and value
rectangles displayed in the interpreted view window.

Field rectangles. Field rectangles (the large rectangles), name the fields
analyzed by the MPEG Program Stream Analyzer and display marker bit
indicators, when marker bits are part of the field. If marker bit values are
incorrect, marker bit indicators (the vertical lines) are displayed in red.
Shaded or gray rectangles represent fields that are important indicators of the
quality of the program stream.

Double-click a field rectangle to display a pop-up message window for the
field, as shown in the following illustration. The title bar of the message
window names the field; the text below describes the field as defined by
ISO/IEC 11172-1 and ISO/IEC 13818-1. You can move this window by
clicking and dragging the title bar. Dismiss the window by clicking
anywhere outside of it in the application window.

MTS300 Series Program Stream Analyzer
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[ DRAGONDVD PRG -> Stream id 224

PES Packet Item 1 - Pasition : 3133 byrtes ﬂ

packet start | [ stream
code prefix il

——324—— 33— A 16 bit field specifying the number
10 FES |: of bytes in the PES packet following [DTs|| ESCE || ES rate DSI trick
2

scrawbling | | p1 the last byte of the field. A value of 0 jgs flag flag mode flag | o
contral indicates that the PES packet length

is neither specified nor bounded and
III is allowed only in PES packets ZI | o | | 0 | | 0 | I:
— s . . ] ] —— — | ———— —
whose payload is a video
0011 (| PTS || 0001 elementary stream contained in acket F-5TD | |reserved| | PES extensior
‘ ‘ Transport Stream packets. pounter | | buffer flag field flag 2

4
A I ecand T TR A A 1T A 1T n 1T P 1711 A

Double-clicking on field rectangles that look three dimensional opens a
hexadecimal view of the bitstream for the item displayedBseary and
Hexadecimal Viewen page 2-10 for a description of the hexadecimal
view window).

| [ e e | | v |
strear || '11" STD buffer STD buffer ([ Data
id hound scale gize bound
[[224 ][ 3 || 1 [[ 2 [3w0s]
-
al | A

m  Value rectangles. Value rectangles (the small rectangles) display the value for
the field named in the large rectangle directly above it. Values can be
displayed in either decimal or hexadecimal base. To toggle between decimal
and hexadecimal base, pressfdunction key. Values displayed in red
indicate values that are in error.

Double-click a value rectangle to display a pop-up message window for the
value, as shown in the following illustration.

[ DRAGONDVD PRG -> Stream id 224

PES Facket Itetn | - Position : 3133 bytes :I

packet start | | stream | [PES packet
code prefx id length

——24—— «—i— Inumber of bytes in the PES packet

10 PES Ffulluwing the last byte of this field EH ESCR. ‘ESrate H DSI trick
serambling | | prmorTy T ADEIOEIT T T ToRy 1T T flag flag rande flag

[

MTS300 Series Program Stream Analyzer 2-9
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The message window interprets the value for that field, and reports any
errors encoded in the bitstream. If marker bits are part of the field, the
message window also reports whether the marker bit values are correct.
Dismiss the message rectangle by clicking anywhere outside of it within the
application window.

Three dimensional value rectangles to display the number of data bytes
encoded in the bitstream for that item.

Navigating through interpreted view items. Use the Edit toolbar command buttons
(located at the bottom of the application window) to navigate through the items
of the element displayed. See Table 2-2, on page 2-3 for more information
about how to use the Edit toolbar command buttons.

NOTE. Itemsare instances of specific data types, or elements. The first instance
of the program_stream_map() element in the bitstream is the first item displayed
in the PSM interpreted view.

Binary and Hexadecimal ~ The Binary and Hexadecimal views show the bit representation, in either binary
Views  or hexadecimal format, of the interpreted view from which it was accessed.
Access Binary and Hexadecimal views from interpreted view windows by
clicking the Add Viewicon on the upper toolbar and selecting Binary or
Hexadecimal from the submenu.

The blue text in the binary and hexadecimal views represent the data that appears
in the first line of the item displayed in the interpreted view.

Navigate through the items represented in the binary or hexadecimal view using
the Edit toolbar or the Edit menu selections. As you move through the items in
binary and hexadecimal views, the interpreted view from which you accessed the
binary or hexadecimal view also increments. In order to display two separate
items of the same element, you need to display two interpreted view windows
and access a binary or hexadecimal view from each.

You can also display binary and hexadecimal views of many program stream
elements by double-clicking the three dimensional data packet fields in some of
the interpreted views.
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Basic Operations

This section describes how to open, extract, and save MPEG program and
system stream files; how to print information displayed in interpreted and
hierarchic views; and how to exit the application.

Opening Program Stream  The MPEG Program Stream Analyzer can display the following types of files:

Files
m MPEG2 program streams
B MPEG1 system streams
® MPEG1 and MPEG2 PES packet streams
Opening a program stream file. To open a program stream file, use the following
procedure:
1. Select the Open command button on the Upper toolbar (or Sglectfrom
the file menu).
Open HE
File: name: Folders: oK
Im hprog_stmshprg2 _
Cancel |
|||'r:r-...-'[:-.F-F:|3 = %Cﬁ\,og_sm -
SR Pes & PRG2
[ -
Lizt filez of type: Dirives:
MPEGZ2 Program Streanj I Hc j Metwork... |
MPEG2 Packets [PES]
MPEGT System Stream
MPEGT Packets
2. Use standard Windows techniques to select the drive and directory that
contains the file you want to open.
MTS300 Series Program Stream Analyzer 2-11
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3. From thelist files of type: drop-down selection box, make one of the
following selections (the list describes the elements that the analyzer
displays when you select the option):

m  MPEG2 Program Strearfhis will display all of the elements in
program or system stream files (opening a file as an MPEG2 Program
Stream is the default option).

®  MPEG1 System Strearfhis will display all of the elements of system
stream files. If the file opened using this option is an MPEG2 encoded
file, the PSD and PSM elements will not be displayed.

m  MPEG2 PacketsThis will display all of the PES packet elements
encoded in the program or system stream. Program and system stream
level information is not displayed when you use this option.

m  MPEG1 PacketsThis will display all of the MPEG1 PES packet
elements encoded in the program or system stream. If the file is an
MPEG2 encoded bitstream, the MPEG2 elements will not be displayed.

4. Select the file that you want to display from #ike hame: selection box (or
type the name of the file in the text box), and then s@&ct

The initial display depends on the option you selected in step 3. If you open
a file as a program or system stream, the Hierarchic view is the first view
displayed. If you open a file as packets, an interpreted view is the first view
displayed.

Extracting and Saving ~ You can extract and save complete program stream files or specific parts of the
Program Streams ~ program stream using the procedures described in this section. The following list
indicates how program stream data is saved when different views are active:

m  Pack header interpreted view. When this view is active, the analyzer extracts
the packs you indicate and saves files using the pack file name extension

(-pcR.

m  PSM interpreted view. When this view is active, the analyzer extracts the
indicated program stream map PES packets and saves files using the PSM
packets file name extensiompgn).

m  PSD interpreted view. When this view is active, the analyzer extracts the
indicated program stream directory PES packets and saves files using the
PSD packets file name extensiopsQ.

®  PES interpreted viewVhen this view is active, the analyzer extracts the PES
packets you indicate and saves files using the PES stream file name
extension pes.
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Extracting packs. To extract and save packs from a program or system stream,
use the following procedure:

1. From a Pack header interpreted view, select the Save As command button
from the Upper toolbar (or seleSave afrom the File menu).

2. ChooseAll Packs or Select Numberfrom the dialog box.

m  SelectAll Packs to extract the entire stream (packs, packets, and end
code).

m  SelectSelect Numberto extract the packs you indicate in #em and
To text boxes.

Save PackStream
rPacks—————

& Al Packs

© Select Mumber

From I'I

3. If you choseSelect Number enter the pack item numbers for the packs you
want to save in thErom andTo text boxes. The numbers you enter in the
text boxes are inclusive.

4. After you press OK, a standard Save As dialog box is displayed. Using
standard Windows techniques, indicate the file in which to save the extracted
data.

Pack header data saved using this procedure are saved using the pack stream
file name extensionck).
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Extracting packets. To extract and save packets from a program or system stream,
use the following procedure:

1. Navigate to the interpreted view for the stream element you want to save,
and then select the Save As command button from the Upper toolbar (or
selectSave adrom the File menu).

The Save PES Streandialog box is displayed with the following
parameters:

m  TheAll Stream ID andAll Packets options are selected.

m  The stream ID of the active interpreted view is displayed ifstheam
ID text box.

B The item number displayed in the active interpreted view is displayed in
theFrom andTo text boxes.

Save Pes Stream
~PesPackets—————— - Packet Stream ID —
i Al Packets & Al Steams (D
© Select Mumber " Select Stream (D

From Stieam D [158
N —

Cancel |
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Use Table 2—4 to determine the choices you need to make from the Save PES
Stream dialog box options.

Table 2-4: Save PES Stream option matrix

PES Packets group Packet Stream ID group
All Streams ID Select Streams ID

All Packets Extracts all of the PES packets | Extracts all of the packets for the
in the stream. indicated element from the stream.

Indicate which element to extract by
entering its stream ID in the Stream

ID text box.
Select Number Extracts all of the packets inthe [ Extracts n number of x elements from
range of PES packets you the stream.

indicate in the From and To text
boxes. The range entered in the
text boxes is inclusive.

n represents the number of items
found in the range of packets indi-
cated in the From and To text boxes.
The range is inclusive and begins
with the item listed in the From text
box. For example, entering 12 and 18
in the From and To text boxes will
extract seven items of element x,
starting with the 12th such item in the
stream.

X represents the element you want to
extract. You determine which element
to extract by entering the appropriate
stream ID in the Stream ID text box.

2. After you have chosen the options you want fromRas Packetand
Packet Stream IDgroups and have entered the appropriate values in the text
boxes, select OK and a standard Save As dialog box is displayed.

3. Select the drive, directory, and file name of the new file you will create using
the options in th&ave adialog box.

You can make managing your files easier if you use the following suggested
file name extensions:

m  Use.psdfor program stream directory files.
m  Use.psmfor program stream map files.
m  Use.pesfor packetized elementary stream files.

4. SelectOK.
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2-16

If you entered a number into either thi@m or To text box that is greater
than the total number of items in the stream for the element you are
extracting, you will see aBnd of Fileerror message and the resulting file
may be unusable.

Extracting elementary streams. You can extract elementary streams using one of
the following procedures:

1.
2.

Double-click a Video, Audio, or Data icon.

Use standard Windows techniques to select the drive, directory, and file
name you will create using the options provided inShee agdialog box.

The default file name extensions for saving elementary streams are indicated
in the following list (these extensions are automatically appended to the file
name displayed in theile Name: text box):

Video streams usid file name extensions.
Audio streams usaudfile name extensions.

Data streams usdatfile name extensions.

You can also use the Elementary Stream selection from the View menu to extract
and save elementary streams.

1. Navigate to the Hierarchic or PES packet interpreted view for the elementary
stream you want to extract, and then sdidementary Streamfrom the
View menu.

2. Enter the stream ID for the elementary stream you want to extract in the
dialog box.

Select ES to save

Stream 1D Mumber : 224

[decimal walug]

ok | Cancel |

3. Use standard Windows techniques to select the drive, directory, and file

name you will create using the options provided inShee agdialog box.

The default extension for all elementary streams saved using this procedure
is.es
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Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Operating Basics

Finally, you can automatically display an elementary stream and analyze it using
the MPEG Audio Stream Analyzer or the MPEG Video Stream Analyzer, if the
Elementary Stream Analyzer is installed on your system:

1. Right-click an Audio or Video icon.

2. Select eitheAnalyze with Video Stream Analyzeror Analyze with Audio
Stream Analyzerfrom the submenu.

The appropriate application will be opened with the extracted elementary
stream displayed.

Printing Program Stream  You can print the information displayed in the hierarchic, interpreted, hexade-
Data  cimal, and binary view windows. To print a view window, use the following
procedure:

1. SelectPrint Setup from the File menu, and then use the options provided in
the dialog box to configure the printer and document characteristics for your
document. (This step is optional.)

2. SelectPrint from the File menu and use standard Windows techniques to
send the file to the printer.

Quitting the MPEG ~ To quit the MPEG Program Stream Analyzer, sefedt from the File menu.
Program Stream Analyzer
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Menu Selections

Table 2-5 is a quick reference to the menu selections of the MPEG Program
Stream Analyzer and briefly describes what happens when you make the menu
selection. Page references indicate the page on which you can find more
information about specific menu selections.

Table 2-5: Menu selections

Menu Selection Result
File Open Displays the Open dialog box from which you
identify the existing file you want to view. See page
2-11.
Save as Displays the Stream Save dialog box from which
you indicate which portion of the stream you want to
save. See page 2-12.
Print Displays a standard Print dialog box from which you
can print the active view window.
Printer setup Displays the Page Setup dialog box. The dialog box
also provides access to printer options.
Exit Quits the MPEG Program Stream Analyzer.
Edit Next ltem Displays the next item in the active view.
Previous Item Displays the previous item in the active view.
First Item Displays the first item in the active view.
Last Item Displays the last item in the active view.
Goto Displays the specified item in the active view.
Number of ltems Calculates the number of items in the active view,
and then displays the number in the upper portion of
the active view window.
Next error Displays the next item in the active view with either
a CRC or syntactic error.
View Packs View Displays the Pack header interpreted view for the
active program stream. See page 3-2.
(PES) Packets Displays a dialog box in which you enter the stream
ID of the elementary stream you want to view. See
page 3-3.
Elementary Stream Displays a dialog box in which you enter the stream
ID of the elementary stream you want to extract.
See page 2-16.
PS Map Displays the program stream map interpreted view
for the active program stream. See page 3-4.
PS Directory Displays the program stream directory interpreted

view for the active program stream. See page 3-5.
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Table 2-5: Menu selections (cont.)

Menu Selection

Result

Analysis Characteristics

Multiplex Rate

Displays the multiplex rate for the program stream.

Packs/Packets Map

Displays the Pack Headers/Packets Map view
showing the distribution of stream_IDs and packets
for the program stream. See page 3—7.

Syntactic/Semantic

Initiates a syntactic analysis on the active stream or
element. See page 3-14.

Consistency

Initiates an analysis on the consistency of active
stream. See page 3-15.

Temporal

SCR

Initiates an analysis of the system clock reference
clocks for the active program stream. See page 3-8.

PTS/DTS

Displays a dialog box in which you enter the stream
number of the elementary stream upon which you
want to perform a presentation/decoding time stamp
analysis. See page 3-10.

Automatic

Initiates the analyses selected using the Automatic
Analysis selection from the Options menu. See
page 3-17.

Options DVD

Inactive. This menu selection will be used in future
enhancements.

Automatic Analyses

Displays a dialog box from which you select the
types of analyses you want performed when you
select Automatic from the Analysis window.

See page 3-19.

Interpretation

Displays the Interpreted view option dialog box from
which you can choose to display either the length or
the position of the structures in the interpreted
views. See page 3-22.

Base

Displays the Base dialog box from which you set the
numeric base (decimal or hexadecimal) used for
various views.

Messages Output

Displays a dialog box from which you can select the
drive and directory into which the output from
analyses are written. For each program or system
stream file analyzed, one .log file is generated. To
prevent this file from being appended to, copy it into
another location or rename it. See page 3-20.

Font

Displays the Font dialog box from which you set the
font used for most of the views windows. (The
Binary and Hexadecimal view windows are not
affected by the font selection.)

MTS300 Series Program Stream Analyzer
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Table 2-5: Menu selections (cont.)

Menu Selection Result
Options Configuration
Save Saves the current analyzer configuration.
See page 3-22.
Load Loads a saved configuration file into the current
MPEG Program Stream Analyzer session. See page
3-22.
Default Loads the default configuration into the current
MPEG Program Stream Analyzer session. See page
3-22.

Window Cascade Overlaps the open windows on top of one another.

Tile Fits the open view windows to the application
window.

Arrange icons Arranges all minimized window icons to the bottom
of the application window.

Close view Closes the selected view window.

Close all Closes all of the view windows.

Add view Displays a submenu from which you can choose to
add a view window identical to the selected view or
a different view of the displayed information. See
page 3-6.

Open view windows Lists all of the open view windows, including any
minimized windows. Select a view window from the
list to make it the active view window. A checkmark
indicates the active view window.

Help Contents Displays the MPEG Program Stream Analyzer Help
contents from which you can choose or search for a
specific help topic.

Using help Displays the Windows Help contents.

About MPEG Audio Stream | Displays the software version number and copyright

Analyzer information about the MPEG Program Stream

Analyzer.
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Interpreted Views

Referencerovides detailed information about the MPEG Program Stream
Analyzer. This chapter is organized into the following sections:

m Interpreted Viewslescribes each of the interpreted views enabled by the
MPEG Program Stream Analyzer.

m  Additional Viewsdescribes other views used by the analyzer to display and
interpret program stream data.

B Analyzing Program Streantescribes the types of analyses available using
the MPEG Program Stream Analyzer.

m  Options Menu Referengeovides a reference for the Options menu
selections that allow you to configure the MPEG Program Stream Analyzer.

NOTE. For information about common Windows interface elements such as scroll
bars and window controls, see your Windows documentation.

Interpreted views provide a graphical user interface for examining MPEG
program stream elements. This section describes individual interpreted views and
is organized alphabetically.

Seelnterpreted View Windowseginning on page 2—7 for a description of, and

how to use, common interactive characteristics of interpreted view windows such
as, navigating through the items of an interpreted view and descriptions of the
interface elements.

NOTE. The MPEG Program Stream Analyzer analyzes both program and system
streams. The illustrations in this section show the interpreted view windows for
an MPEG2 program stream. The interpreted views of MPEG1 system streams
are similar, but will typically look simpler. Furthermore, system streams do not
have program stream map and program stream directory PES packet elements.
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Pack Header View

3-2

The Pack header interpreted view displays the values found in pack_header()
and, if present, system_header() elements. Display the Pack header interpreted
view window by double-clicking the PS or Pack icon from within the Hierarchic
view window (both icons display the Pack Header interpreted view). Alterna-
tively, selectPacks Viewfrom the View menu.

Pack header data is given on the first line of the display, system header informa-
tion is given in the second line, and elementary stream specific information is
given on subsequent lines.

. Pack View of Default.pck

Ttern 1 - Position : 0 bytes il
pack start | [ 01" system clock systern clock program | [reserved pack
code reference bage, | peference extensionf | ron zate stuffing
| 1| || ength
L Lo Jl o J[ o Jlowe [l j[ 5 |
3 35 Q. ) 5
stuffing | |systern header| | header rate audin | fixed flag) | C5F5 | pwstern audio| systern video| | video packet
biytes start code length bound || hound flag lock flaz Inck flaz b0u|.nd restrictio
s JL e [ w2 J[oswolf[ ¢ [ [ o [ o J[ o J[1 ][ 4
— e — ) s — ] ] ] —— ] 5 ] -
stream | [ 11 STD bmffer STD buffer || stream || '11' STD bmffer STD bmffer ||| Data
id hound scale size boumd id bound scale size bound
[[224 ][ 3 ] 1 IHEEERIER ER || s |[313]
—2— 1 13 —2— 1 13
v
| | AW

The following list indicates some of the important Pack header fields displayed
by this interpreted view:

m  System clock reference
®  Program multiplex rate
m  Target decoder data

To view the bytes displayed in the interpreted view in hexadecimal format,
double-click thestuffing bytes or Data field rectangles.

Use the command buttons on the Edit toolbar (or the selections from the Edit
menu) to navigate through the pack header items.
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PES Packet View  The PES Packet interpreted view displays the values found in PES_packet()
elements. Display the PES packet interpreted view by double-clicking a PES
icon from within the Hierarchic view. Alternatively, sel¢PES) Packetdrom
the View menu, and then enter the stream ID of the audio, video, or data stream
you want to view.

1" Default pck -> Stream id 224

Item 1 - Position : 4195 bytes ﬂ
packet start | [ strearn | [PES packet
code prefix il length
ol |[ o0 || owiFs |
— s R | f—
10 FES PES data opyrghtl (ongmal or | |PTS DTS || ESCR. || ES rate D,
scrardbling | | priority || alighroent copy flags flag flag buis
control indicator
[ ][ oo [ w0 J[ w0 J[oo [ o0 |[ 0a |[o0 [[oa J[
—_— | ] ] | —— s | —— ] —— —
o011 (| BTS || 0001 | [ DTS PES packet
1.0 1
[0 |Daras|| oo |Duse3s|| 2029 |
— 35— —d— 33—

4] | v

The following list indicates some of the important PES Packet fields displayed
by this interpreted view:

m  Stream ID

m  Scrambling control

m  Copyright information

m PTS/DTS and ESCR time stamps
®  Target decoder data

m  Previous PES CRC data

m  Trick mode controls and flags

m  Field ID data

To view the bytes displayed in the interpreted view in hexadecimal format,
double-click thePES packet data bytdield rectangle.

Use the command buttons on the Edit toolbar (or the selections from the Edit
menu) to navigate through the PES Packet items.
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Program Stream Map View

The Program Stream Map (PSM) interpreted view displays the values found in
program_stream_map() elements. Display the Program stream map interpreted
view by double-clicking the PMT icon from within the Hierarchic view window.
Alternatively, selecPS Map from the View menu.

[&] Psm View of Default.pck [— (O] =]
-
Program Stream Map Ttera 1 - Position : 14703 bytes ﬂ
packet start Mmap | [program strearn| |curtent newt | [reserved| | program strearn | |reserved| [program strearn) | el
code prefix | |streamid | | map length indicator AR VErsion info length sit
T | I T | I RN AT | T | R |
24 h— 11 —l—— —— 16 —
stream | | elementary | | elementary
type strear id stream info
length
[ L= I o |
— e e |H—
streamn | | elementary | | elementary
type strear id stream info
length
[ 3 L2 | o |
— R — R —— —f——
CRC
4] | H

The following list indicates some of the important PSM fields displayed by this
interpreted view:

®  PSM map ID, length, and version
m  Descriptors
®  Elementary stream IDs and types
m  CRC values

To view the bytes contained in the displayed item seledkddeView command
button, and then seleBinary or Hexadecimalfrom the submenu.

Use the command buttons on the Edit toolbar (or the selections from the Edit
menu) to navigate through the program stream map items. You can check all of
the CRC values in a program stream using\teet error command button from

the Edit toolbar. The analyzer will check the program stream map syntax for the
active stream, including CRC values, and display the next item with an error.
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Program Stream Directory ~ The Program Stream Directory (PSD) interpreted view displays the values found
View in program_stream_directory() elements. Display the PSD interpreted view by
double-clicking the PSD icon from within the Hierarchic view. Alternatively,
selectPS Directory from the View menu.

:C Pszd Yiew of Default. pck

Program Stream Ditectory | Ttera 1 - Position : 31557 bytes f’
packet start | [ divectory | [PES packet| | number of previous | next |
code prefix || stream id length. access ukits directo directo:
| | offset |offset
1 Jlas JLos [ 3 J[ e ][ o ]

— A —F—— ] —— | f—— — i —— 45—

packet FES header FES header | |referenced | [reserved| PTS{Presentatioy | birtes to | | intra coded cod:

stream id | | position offset | | position offset offset Time Starap) read indicator paratn
o i | CTT 1L e
Lz [ o J[ o [ o J[z] o Jlo J[ o J[ o

1 44 35— |3

packst FES header PES header | |referenced | [reserved| PTS{Presentatioy | byrtes to | | intra coded cod:

stream id | [ position offset | | position offeet offset Tirme Starap) read indiator patatn
sign | 1| | | | | | indic
(o2 [ o J[ o Jlo J[a ][ o J[ o ][ o J[ o
1 44 —lf—— e A —— i e— | —— +——]
<|| ranbat || PRS haadar || PRS haadar ||mr nnnnn Al Lacarad] Brafmesantatio] [hetan 40 | [t andaa | [ TILI
o

The following list indicates some of the important PSD fields displayed by this
interpreted view:

m  PES packet length

®  Number of access units

®  Previous and next directory offsets

m  PES header offset of the referenced access unit
B PTS of the referenced access unit

To view the bytes contained in the displayed item, sele&dideVview
command button, and then selBimary or Hexadecimalfrom the submenu.

Use the command buttons on the Edit toolbar (or the selections from the Edit
menu) to navigate through the program stream directory items.
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Additional Views

Adding Views

3-6

This section describes additional views used by the MPEG Program Stream
Analyzer to display program and system stream data.

You can add multiple view windows to the application window using one of the
following techniques:

®  Select theAdd View command button from the Upper toolbar, and then
select the view you want displayed from the submenu.

m  SelectAdd View from the Window menu, and then select the view you want
displayed from the submenu.

Table 3-1 lists the views you can add from within the view windows indicated.

Table 3-1: Add view options

View window Add view options
Hierarchic view An identical Hierarchic view
Interpreted view An identical interpreted view
A Binary or Hexadecimal view
Binary or Hexadecimal view An interpreted view of the bitstream
A Binary or Hexadecimal view
SCR view An SCR Graphic view
An SCR Values view
PTS/DTS view A PTS/DTS Graphic view
A PTS/DTS Values view

The Add View command button and menu selection are not available from the
Multiplex Rate and Pack Headers/Packets Map view windows.

If you add views using the Add View command button (or menu selection), and
then navigate to another item using the resulting window, the first window (the
parent window) also displays the new item. In order to view multiple, unique
items of program stream elements, add another interpreted view window by
selecting the appropriate icon from the Hierarchic view.
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Binary and Hexadecimal ~ Binary and Hexadecimal views show the bitstream of the interpreted view from
Views  which it was accessed in either binary or hexadecimal format. Access these
views from interpreted view windows by clicking thdd View icon on the
upper toolbar and selectiijnary or Hexadecimalfrom the submenu.

The blue text in the binary and hexadecimal views represents the data that
appears in the header of the interpreted view.

You can also display binary and hexadecimal views of many program stream
elements by double-clicking the three dimensional data packet fields in some of
the interpreted views.

Multiplex Rate View  The Multiplex Rate view window displays the multiplex rate for the active
program stream. Display the multiplex rate using one of the following methods:

m  Right-click a PS or Pack icon, and then selRate from the submenu.

®  From the Hierarchic view, seleCharacteristics from the Analysis menu,
and then seledflultiplex Rate from the submenu.

The Multiplex Rate view window is a static display.

Pack Headers/Packets = The Pack Headers/Packets Map view window displays the distribution of the
Map View  program stream items in the packets of the program stream. To display the Pack
Headers/Packets Map view window, use one of the following techniques:

®  Right-click the PS or Pack icon, and then seRaatkets Mapfrom the
submenu.

B From the Hierarchic view, seleCharacteristics from the Analysis menu,
and then sele®acks/Packets Magfrom the submenu.

B Pack Headers/Packets Map for Hierarchic Yiew of DRAGONDYD PRG

packs 1 to 188 il
PACK PSH PSD Audio Video

(0000001) 9186 0187 0186 0224 89186 0224 8224
(0000011) 68186 0224 9186 0224 9186 0224 B186 0224 8224 6186
(00000621) 6224 0186 6224 6186 0224 A186 B224 0224 @186 0224
(0088631) 8186 0224 B186 8224 @186 ©B224 0186 8224 8186
(0000041) 6224 0186 6224 0224 9186 0224 9186 0224 8186 0224
(0080051) 9186 0224 0224 @186 0224 @186 0224 0186 6224 8186
(8000a61) 6224 8186 0224 @186 0224 @186 0224 B224 B186
(0000671) 6224 0186 6224 6186 0224 A186 8224 0224 @186 6224
(00080081) ©186 0224 B186 8224 @186 0224 0224 B186 6224 8186
(80000691) 0224 0186 8224 @186 0224 0186 08224 @186 8224

1] | AP
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SCR Clock Views

3-8

This view of the program stream shows the distribution of packets and indicates
the type and stream ID of the data encoded in each packet. Each Pack Headers/
Packets map window displays up to 100 packets.

®  The color reference at the top of the window maps the colors used in the text
below to the program stream elements that can be displayed using the MPEG
Program Stream Analyzer. Not all of the data types will be found in every
program stream.

B The numbers in parentheses along the left-hand side of the window are the
packet numbers for the first packet shown in that row.

The first colored text in a row represents the packet whose number is
indicated in parentheses immediately to the left.

®  The colored text indicates the stream ID of the data encoded in that packet.

SCR clocks are used as timing references at the decoder for the program stream
and are encoded in the pack layer. The MPEG Program Stream Analyzer
analyzes and displays system clock reference data using two SCR Clock views:
an SCR Graphical View and an SCR Values View.

SCR Graphic view. To display the graphical SCR view window, using one of the
following techniques:

®  From the Hierarchic view, right click tHeS or Packicon, and then select
SCR from the submenu.

®  From the Hierarchic view, seletémporal from the Analysis menu, and
then selec6CR from the submenu.

Frogram Packs

Rate
Packets Map
SCR

When you display the SCR Clock View, the MPEG Program Stream Analyzer
analyzes the SCR data for the active program stream. If errors are found during
the analysis, they are indicated on the display as red arrows leading from SCR
clock icons to the black line, which represents time. SCR clocks without errors
are indicated using black arrows.

MTS300 Series Program Stream Analyzer
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Each SCR view window displays ten SCR clocks, starting with SCR numbers

one through ten. If successive clock references are very close together (in time),
some of the clock reference icons may not be visible. To access the data for these
clock references you need to display the SCR Values view, which is described in
the next section. Click thidext Item command button to display successive

SCR items or use th@o to Item button to display a specific item.

To display the values associated with each clock, double-click one of the SCR
icons and an SCR numbepop-up window is displayech {s the number of the
clock reference you double-clicked). See the previous illustration. In this display,
bad SCR values are displayed in red. You can drag this pop-up window to a hew
position by clicking and dragging the title bar. Dismiss the window by clicking
anywhere outside of the pop-up in the application window.

% SCR = (O] x|
4
SCH. nuraber 561 to 570
SCR Icon = B
- T
0.546326
SCR Base 49399 units
SCR Extension 107 units
SCR Value [SCRV] 0.548881741 sec
Interpolated SCR [SCRI] 0.548069048 sec
. SCRI- SCRY -0.000812693 sec
SCR Values pop-up window Previous SCR Arrived Since 0.001659519 sec
Pack Number 563
Program Mux Rate 10080000.0 bps
First Byte of Pack delivered[FBF] 0.548875392 sec
Last Byte of Previous Pack delivered[LBPP]0.548061905 sec
FBP - LBPP 0.000813487 sec
< | vl

Some of the displayed values are encoded in the program stream itself (for
instance, SCR Base and SCR Extension values) and some are derived (for
instance, SCRI — SCRV and FBP — LBPP values). Derived values are based on
the values encoded in the program stream multiplex rate, SCR base, and SCR
extension fields.

SCR Values view. In the graphical view, some of the SCR clocks may not be
visible. This occurs when the time between successive clocks is too small for the
display to resolve. However, the SCR Values view window displays the SCR
values for all ten SCR clocks. To access this display, click the Add View button
while the SCR graphical display is active, and then select SCR Values from the
submenu.

MTS300 Series Program Stream Analyzer 3-9
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Use the scroll bar to view the values for the ten displayed clocks. Clitkettte
Item command button to display successive clocks, or usédhe Item

command button to select a specific system clock reference to display. As with
the graphical display, red values indicate errors.

PTS/DTS Clock Views ~ PTS/DTS clocks are used as timing references at the decoder for presentation
and decoding the access units of the PES packets in which they are encoded. The
PTS/DTS Clock views display presentation and decoding time stamps for the
selected elementary stream. Like SCR clocks, you can display PTS/DTS clocks
in both graphical and numerical formats.

PTS/IDTS Graphic view. To display the graphical view of PTS/DTS clocks,
right-click a PES packet icon, and then chd®@$&/DTS from the submenu.

PTS/DTS of Default.pek [ES 1) =] E3
.
PTSLTS Clock View PTSDTS rurakber 21 to 24 j

| |

10122309 1.154460 1.200700

B

Value 1170700000 sec
Packet PES number 324

DTS is before arrived time of a complete access unit

| | _l2||

You can also display the PTS/DTS view window using the following procedure:

1. From the Hierarchic view, seletémporal from the Analysis menu.

2. SelectPTS/DTSfrom the submenu.

NOTE. You cannot perform PTS/DTS analyses on data elementary streams.
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3. Inthe PTS/DTS Analysis dialog box, enter the streamberof the audio
or video elementary stream for which you want to display the PTS/DTS
values, and then cliokK.

PTS/DTS Analysis

Elementary Stream M* : I

[range : 1 to B0O)

Cancel |

Use the number of the stream as it appears in the hierarchy of the Hierarchic
view. For instance, if the Hierarchic view for the active file looked like the
following illustration, you would enter “2” in theTS/DTS Analysistext

box to analyze the audio elementary stream. You would enter “1” to analyze
the video elementary stream (do not enter the stream ID).

"1 Hierarchic View of Zomopy.pes

2

Park

Elementary Stream “1”

Elementary Stream “2"

i’ 110001
Pes 190  DATA

o | o

When you display the PTS/DTS view, the MPEG Program Stream Analyzer
analyzes the PTS/DTS values for the active program stream and displays the first
four PTS/DTS items. If successive time stamp references are very close together
(in time), some of the PTS or DTS icons may not be visible. To access the data
for these references you need to display the PTS/DTS Values view, which is
described in the next section beginning on page 3-13.
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If errors are found during the analysis, they are indicated on the display as red
arrows leading from PTS/DTS icons to the black line, which represents time.
PTS/DTS clocks without errors are indicated using black arrows. Udéettie

Item command button to display successive PTS/DTS items or uSotte

Item to display a specific item.

Table 3-2 lists the icons used in the PTS/DTS view and indicates the type of
information displayed when you double-click the icon.

Table 3-2: PTS/DTS view icons

lcon | Represents! Double-click to display

SCR number n The system clock reference value associated with the
displayed access units.

The item number of the pack containing the SCR value.

Arrived number n The time that the access unit (the encoded data for a
picture or block of sound) arrived at the decoder.

The elapsed time since the last bit of the previous PTS/DTS
field arrived at the decoder.

The PES packet number containing the displayed access
unit.

PTS number n The presentation time stamp value.

The PES packet item number containing the PTS value.

@I DTS number n The decoding time stamp value.

The PES packet item number containing the DTS value.

N

—— | Access Unit number n | The time that the first bit of the displayed access unit was
decoded (relative to the first SCR clock).

The time that the last bit of the displayed access unit was
decoded (relative to the first SCR clock).

The number of bytes in the displayed access unit.

The type of picture for the selected access unit: B-, P-, or
|-Picture3,

The sequence in which the decoded pictures are to be
displayed relative to the most recent I-picture3 (Reference
time for |-pictures is zero).

1 nrepresents the position of the displayed data relative to the first like data item in
the program stream. For example, PTS number 2 means that the displayed PTS value
is the second instance of the presentation time stamp in the program stream.

2 Access Unit icons can represent multiple access units.

3 Picture type and sequence information is displayed only for video elementary
streams.
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The message windows displayed when you double-click icons in the PTS/DTS
view show errors in red. You can drag these windows to a new position by
clicking and dragging the title bar. Dismiss the windows by clicking anywhere
outside of the pop-up in the application window.

PTS/DTS Values view. In the graphical view, some of the presentation/decoding
time stamps and access unit icons may not be visible, or may be difficult to
select. To display all of the values represented in the active PTS/DTS view, click
the Add View button, and then seleefTfS/DTS Valuesfrom the submenu.

In the PTS/DTS Values view, PTS/DTS values are displayed in the two left
columns, and access unit data is displayed in the two right columns. The total
number of access units displayed is listed at the top of each window. Red values
indicate errors.

R PT5/DTS of DRAGONDVD PRG [ES 1):2 H=] E3
.

PTS/DTS walue : MNb Access Unit: 44

PTS/DTS number 1 Access Unit number 1

Reference SCR number 2 1 0.000000000 sec Begin AU : 0.000058
Packet PES number 1 End AU 1 0.037985
Arrived value 1 0.000010317 sec Size AU 146272 by
Previous PTS{DTS 1 0.000000000 sec Type *intra 1]
PTS wvalue : 0.179666667 sec Reference time 10

DTS value 10129622222 sec

Access Unit number 2

PTS/DTS number 2 Begin AU : 0.037985
Reference SCR number 59 :0.112910296 sec End AU : 0.056161
Packet PES number 170 Size AU 121628 by
Arrived value : 0113265852 sec Type . predicted
Previous PTS/DTS : 0.113255534 sec Reference time 12
PTS wvalue : 0.646800000 sec
DTS wvalue : 0596755556 sec Access Unit number 3

Begin AU : 0.056161
PTS/DTS number 3 End AU :0.063414
Deference S0 numbar 127+ 0 'unnrm:l:n car Cize All - an2a hjﬂ

4
- J - J
Y '

PTS/DTS values columns Access unit columns

Use theNext Item command button to display successive PTS/DTS items, or

use theGo to command button to select a specific item.

MTS300 Series Program Stream Analyzer
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Analyzing Program Streams

Syntactic Analysis

3-14

The MPEG Program Stream Analyzer provides multiple analysis functions for
checking different aspects of MPEG program and system streams. The following
analysis functions are described in this section:

m  Syntactic analysis. Syntactic analyses check the conformance of the values
encoded in the bitstream to MPEG standards.

m  Consistency analysis. Consistency analyses check the conformance of the
fields and values encoded in the bitstream relative to each other as required
in the MPEG standards for program and system streams.

m  SCR analyses. SCR analyses checks the temporal references for the program
stream.

m PTS/DTS. PTS/DTS analyses checks the temporal references for a specific
elementary stream.

One of the Analysis menu selectiong\igomatic, which initiates any combina-
tion of the above analyses. S&gtomatic Analysesn page 3—19 for more
information about setting the options for automatic analyses.

Syntactic analyses check the conformance of the values encoded in the bitstream
to MPEG standards. You can perform syntactic analyses on a specific MPEG
element or on the entire program stream. To perform an analysis on the entire
stream, use the following procedure (to perform a syntactic analysis on a selected
element, use the same procedure, but first make the interpreted view of the
element you want to analyze the active view):

1. Navigate to the Hierarchic view for the program stream you want to analyze.
2. SelectSyntactic Semanticfrom the Analysis menu.
The analyzer initiates a syntactic analysis of the program stream.

After the analysis is complete, the following message window is displayed
listing the syntactic errors found in the file.

Errors are listed by MPEG element, item number, field name, and error.

&5 Message for Hierarchic View of DRAGONDVD.PRG
- item #1 - Field: reserved -> Error, value must be "11' [0x3].

- item #2 - Field: reserved -> Error, value must be '11' [0x3].
- item #3 - Field: reserved -> Error, value must be '"11' [0x3].
- item #4 - Field: reserved -> Error, value must be "11° [0x3].
PSM - item #5 - Field: reserved -> Error, value must be "11" [0x3].
PSM - item #6 - Field: reserved -> Error, value must be "11" [0x3].
PSM - item #7 - Field: reserved -> Error, value must be "11" [0x3].
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3. To display the interpreted view for item containing an error, double-click an
error message.

The appropriate interpreted view is displayed and the value in error is
displayed in red.

=" Psm View of DRAGONDYD.PRG 1 [m] 3
Progra Strearm Map Itern 3 - Position : 424107 bytes —
packet start map | [program strear| | current next | reserved| | program strear | [reserved| (prograrn stream| [ elementary
code prefix | |streamid || map length indicator mMap version info length stream rmap
| length
1 e [ 2 JL o1 Jl2 [ 3 Jw][ o || 1z |

—d- 16 —_—] e s | f—

strearn | | elementary elementary |
type EEcRE R NP 2 M essage for Hierarchic Yiew of DRAGONDYD.PRG

ength - item #1 - Field: reserved -> Error, value must be '11" [Dx3].
| 1 || 224 || 0 |PSM - item #2 - Field: reserved -> Error, value must be '11' [0x3).
Tl PSM - item #3 - Field: reserved -> Error, value must be '11° [0x3].
stream | |elementary | | elerments | PSM - item #4 - Field: reserved -> Error, value must be '11° (0x3).
type strearn id streare it | PSM - item #5 - Field: reserved -> Error, value must be "11° [0x3].
length |PSM - itemn #6 - Field: reserved -> Error, value must be "11' [0x3]. _l_l

[ [ ][ ot '
16

[ atrearn | [alomantarer | [ clamentaree |

-

| Mz

When you perform a syntactic analysis on a program or system stream, or any
element of a stream, the analyzer creates a text file of the resulting errors (see
Messages Outpuin page 3—-20).

Consistency Analysis  Consistency analyses check the conformance of the fields and values encoded in
the bitstream relative to each other as required in the MPEG standards for
program and system streams. Consistency analyses can only be performed from
the Hierarchic view. To perform a semantic analysis, use the following proce-
dure:

1. Navigate to the Hierarchic view for the program stream you want to analyze.
2. SelectConsistencyfrom the Analysis menu.

The analyzer initiates a semantic analysis among the elements and fields of
the program stream.

3. After the analysis is complete, a message box similar to the syntactic
analysis message window is displayed listing all consistency errors.

When you perform a consistency analysis on a program or system stream, the
analyzer creates a text file of the resulting errors &essages Outpuin
page 3-20).
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3-16

Temporal Analysis

You can perform two types of temporal, or time-based, analyses on program
streams: SCR and PTS/DTS analyses. SCR clocks are used as timing references
at the decoder for the program stream. PTS/DTS clocks are used as references for
the elementary stream in which they are encoded.

SCR analysis. To perform an SCR analysis on a program stream, use the
following procedure:

1.

Right-click the PS or Pack icon, and then seB€R from the submenu.
(Alternatively, selectemporal from the File menu, and then sel&&R

from the submenu when the Hierarchic view or Pack header interpreted view
is active.)

The SCR Clock Viewis displayed. SeSCR Clock viewkeginning on
page 3-8 for details about how to interpret the resulting display.

PTS/DTS analysis. To perform a PTS/DTS analysis on a program stream, use the
following procedure:

1.

Right-click a video or audio PES packet icon, and then sRlESIDTS

from the submenu. (Alternatively, sel@d&mporal from the File menu, and
then selecPTS/DTSfrom the submenu when the Hierarchic view or Pes
Packet interpreted view is active.)

If you selectedPTS/DTSfrom the File menu, theTS/DTS Analysisdialog
box will be displayed. Enter the number of the video or audio elementary
stream you want to analyze in the text box.

PTS5/DTS Analysis

Elementany Stream M* I

[range : 1 to B0)

Cancel |
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Use the number of the stream as it appears in the hierarchy of the Hierarchic
view. For instance, if the Hierarchic view for the active file looked like the
following illustration, you would enter “2” in thBTS/DTS Analysistext

box to analyze the audio elementary stream. You would enter “1” to analyze
the video elementary stream (do not enter the stream ID).

"1 Hierarchic View of Zomopx._pes

Elementary Stream “1”

Elementary Stream “2”

[y LuIuy ]
i 100110
| 0001

Pes190 DATA

4] | o

3. ThePTS/DTS Clock Viewis displayed. SeBTS/DTS Clock views
beginning on page 3-10 for details about how to interpret the resulting
display.

Automatic Analysis ~ The Automatic analysisselection from the Analysis menu allows you to
perform any combination of analyses described in this section without having to
select them individually. When you perform an automatic analysis on a stream,
the analyzer creates a text file of the resulting errorsNgssages Outpuin
page 3-20).

To perform an automatic analysis on the active program stream, use the
following procedure:

1. Navigate to the Hierarchic view for the program stream on which you want
to perform the analyses.

2. SelectAutomatic from the Analysis menu.

The resultingAutomatic analysiswindow indicates which analyses are
being performed. (Sekutomatic Analysesn page 3—-19 for information
about how to specify which analyses are performed when you select
Automatic from the Analysis menu.)
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3. To stop the analysis, press the button at the bottom of the message window.

In the following illustration, the SCR and PTS/DTS analyses have been
disabled, the Syntactic analysis is completed, and Consistency analysis is
being performed.

& Automatic analysis for C:5Prog_Strms\PRG2\DRAGO... =] E

Status Result
Syntactic Completed Errors Completed analysis with errors
Consistency Running... Analysis being performed
SCR —
PTS/DTS ] Disabled analyses

Abort after current task

If errors are detected, the wdgdrors is displayed in red in the row for the
appropriate analysis under the Result column.

4. Double-click the wordrrors, to display a message windows listing the
errors. Double-click an error message in the Syntactic, SCR, or PTS/DTS
analysis message windows and the item in error is displayed in the
appropriate view window.

You can have the analyzer automatically generate an error log file for the
analyzed file using thAnalyses Result Outputdialog box (sedlessages
Outputon page 3-20). This file is appended to each time an analysis is
performed.

NOTE. To generate the error log file, you need to setMlessages Output in file
option in theMessages Output dialog box each time you start an MPEG
Program Stream Analyzer session. See page 3-20.
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Options Menu Reference

DVD

Automatic Analyses

MTS300 Series Program Stream Analyzer

The Options menu selections allow you to configure specific MPEG Program
Stream Analyzer parameters. The parameters in use when you exit the applica-
tion are used to configure the analyzer when you open it again. This section
describes the parameters you can set using the Options menu selections.

This menu selection is inactive. DVD analyses will be supported in a future
enhancement to the MPEG Program Stream Analyzer.

The options you set using tlptions for automatic analysisdialog box allow
you to perform any combination of the analyses describAdahyzing Program
Streamgbeginning on page 3—-14) without having to select them individually.

To specify which analyses should be performed when Automatic is selected from
the Analysis menu, use the following procedure:

1. SelectAutomatic Analysesfrom the Options menu and the Options for
automatic analysis dialog box is displayed.

Options for automatic analyzis [ x|

Choose the analyses you want
to be performed by the
automatic analysis:

¥ Syntactic
0

Cancel |

¥ Consistency

¥ Temporal : PTS/DTS

2. Select any combination of analyses from the dialog box. Until you change
these settings, the selected analyses will be performed every time you select
Automatic from the Analysis menu.
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Base  Use the Base menu selection to determine how the interpreted views display the
program stream values: in either decimal or hexadecimal base. The default is
decimal base. Toggle between the two by pressing2Hanction key.

Base

& Decimal

&+ Heradecimal Cancel |

[Shartcut keyboard @ F2)

Messages Output  Use the Messages Output menu selection to specify the following parameters:

m  Whether an error log file is automatically created when Syntactic/Semantic,
Consistency, or Automatic is selected from the Analysis menu.

NOTE. SCR and PTS/DTS data is logged when automatic analyses are
performed, but not when SCR or PTS/DTS analyses are performed singly.

m |f created, the directory in which the error log file is written.

Analyses Result Output

Meszages Output In File W

File Directarny:

C: b TS 2000 1M

Ok I Cancel

1. To automatically create an error log file, selectMtessages output to File
check box.

If you clear theMessages Output in Filecheck box, no error log file will be
generated when analyses are performed.

NOTE. Each time you exit the MPEG Program Stream AnalyzeM#®ssages
Output in Filecheck box is cleared. You need to select this option each time you
begin an MPEG Program Stream Analyzer session in order to automatically
generate error log files.
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2. Specify the directory into which log files are written by entering a new
directory path in th&ile Directory text box.

Error log files are named using the file name witlog file name extension.
Subsequent analyses results are appended to files without destroying previous
data. Each new analysis is indicated with an error message header providing the
following information:

B View from which the analysis was performed (for Syntactic/Semantic
analyses)

m  Program or system stream file name (for Syntactic/Semantic analyses)
m  Date and time the error messages were generated

For automatic analyses, the following headers are also used in the body of the
error messages:

m  The type of analysis performed separates the list of error messages (error
messages of a specific type follow the analysis type separator).

®  An End of report for automatic analysssatement indicates where the error
messages for that particular automatic analysis end.

Finally, the error messages in the error log files are formatted similarly to the
error message windows displayed in the analyzer: Errors are listed by MPEG
element, item number, field name, and error.

Font  Use the Font menu selection to specify the font (typeface, style, and size) used
for displaying information in the following analyzer view windows:

m  Hierarchic view windows
®m Interpreted view windows

m  SCR and PTS/DTS Graphic view windows
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Interpretation Use the Interpretation menu selection to specify whether to display length or
position information in interpreted views. The Length and Position check boxes
shown in the following illustration are cleared by default.

m  SelectLength to display the number of bytes in a field.

m  SelectPosition to display the position (in bytes) of the field relative to the
first bit displayed in the interpreted view.

Interpreted view option [ =]

¥ Length ™ Position

Cancel |

Configuration Files  The following Options menu selections allow you to save and load configuration
files.

Read configuration. Choose Read configuration from the Options menu to restore
a configuration file (aacffile) that you saved earlier. A standard Winddsen

dialog box appears. Change the Drive and Directory if necessary and then select
the file name. CliclOK to restore the configuration saved in the file.

Save configuration. Use Save configuration to save the current option settings to
a file. A standard WindowSave agialog box opens. Be sure to select a Drive
and Directory that will make it easy to later retrieve the file; then enter a
descriptive name for the configuration file and cl@K. The file receives the
extension *.acf by default.

Set default configuration. Use this menu selection to revert the current options
settings to the default settings.
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Symbols

?, symbol, 2-5

A

Access unit, icon, 3—12
Add view

menu selection, 2—20

options, 3-6

upper toolbar command button, 2—3
Address, Tektronix, vi
Analysis

automatic, 3—17

consistency, 3-15

CRC, 34

error message output file, 3-20

PTS/DTS, 3-16

SCR, 3-16

syntax, 3—-14
Analyzing program streams, procedures for, 3—14
Application window, 2—2
Arrange icons, menu selection, 2—20
Automatic, analyses procedure, 3—17
Automatic analysis, options, 3—19

B

Base, decimal/hexadecimal options, 3—20
Basic Operations, 2-11
Binary view, 2-10, 3-7
Blue text, in binary and hexadecimal views, 3—7
Buttons

Edit toolbar, 2-3

Upper toolbar, 2—-3

C

Cascade, menu selection, 2—20

Close all, menu selection, 2—-20

Close view, menu selection, 2—20

Color, in pack header/packets map view, 3—8
Common view window elements, 2—4
Configuration, read, save, and set default, 3—22
Consistency, analysis procedure, 3—-15
Contacting Tektronix, vi

CRC, in PSM interpreted view, 3-4

MTS300 Series Program Stream Analyzer

D

Decimal/hexadecimal base, switching between bases,
2-9, 3-20

E

Edit toolbar, 2—-3
Element, definition, 2-4, 2-10
Elementary streams, extracting and saving, 2—-16
End of file, error message, 2—16
Error

log files, 3-18

log files (.log), 3—20

message window, 3-14
Exit, menu selection, 2—-17
Extracting

elementary streams, 2—-16

packets, 2—-14

packs, 2-13

program streams, 2—12

F

FBP (first byte of pack), 3-9

Fields, interpreting position or length, 3-22
First Item, edit toolbar command button, 2-3
First time operation, 1-2

Font, setting, 3—21

Functional overview, 2—-2

G

Go to, edit toolbar command button, 2—-3
Gray rectangles, 2-8

H

Hexadecimal view, 2-10, 3—7

Hexadecimal/decimal base, switching between, 2-9,
3-20

Hierarchic view, overview, 2-5
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I O

Icons Online help, Contents menu selection, 2—20
Edit toolbar, 2—3 Open, upper toolbar command button, 2—3
program stream analyzer, 2—-2 Opening a program stream file, 2—11

PTS/DTS view, 3-12
Upper toolbar, 2—-3
Interface description, interpreted view, 2—7 P

Interpretation, position or length, 3—22
Interpreted views
interface elements, 2—7
pack header, 3-2
PES packet, 3—3
PSD, 3-5
PSM, 3-4
rectangles, 2-8
Item, definition, 2—4, 2-10
Item number, in interpreted view, 2—4, 2—-8

Pack header, interpreted view, 3—-2
Pack headers/packets map, 3—7
Packets, extracting and saving, 2—14
Packs, extracting and saving, 2-13
PES packet, interpreted view, 3—3
Phone number, Tektronix, vi
Position, 2—8

interpreting field, 3-22
Presentation/decoding time stamp

analysis, 3—-16
view, 3—-10
L Previous Item, edit toolbar command button, 2—-3
Print, 2-17
Large rectangles, in interpreted views, 2—8 Product support, contact information, vi
Last, edit toolbar command button, 2—3 Program stream directory (PSD), interpreted view, 3-5
LBPP (last byte of previous pack), 3-9 Program stream map (PSM), interpreted view, 3—4
Length, interpreting field, 3-22 Program streams
List of open view windows, 2—-20 analyzing, 3-14
Log file (.log), generating, 3—20 opening, 2-11
Lower toolbar, 2—3 PTS/DTS

analysis, 3—-16
red text in message windows, 3-10

M
Marker bit indicators, 2—8 Q
Marker bits, interpreted views, 2—8
Menu bar, 2—-3 Question mark, symbol, 2-5
Menu selections, reference, 2—-18 Quitting the application, 2—-17
Message output, options, 3—20
Multiplex rate view, 3—7

R
N Rectangles

interpreted views, 2—38

Navigating, interpreted views, 2—-10 shaded, 2-8
Next, edit toolbar command button, 2—3 Red text
Next error, edit toolbar command button, 2—3 in automatic analysis message window, 3-18
Number of items, edit toolbar command button, 2—3 in interpreted views, 2—9

interpreted views, 3-14
PTS/DTS message windows, 3—-10
SCR message windows, 3-9
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S

Save as, upper toolbar command button, 2—3
Saving

elementary streams, 2-16

packets, 2—14

packs, 2-13
SCR analysis, procedure, 3—16
Service information, vi
Service support, contact information, vi
Shaded rectangles, interpreted views, 2—-8
Small rectangles, in interpreted views, 2—-9
Software version, v
Software version number, v
Start application, 2—2
Status bar, 2-4
Stream number, 3-11, 3-17
Streams

analyzing, 3-14

opening, 2-11

saving, 2-12
Syntactic, error message window, 3—14
Syntactic analysis, procedure, 3—-14
System clock reference (SCR)

analysis, 3—16

view, 3-8

T

Tektronix MPEG Test System, v, 1-2
Temporal analyses, 3—-16

Three dimensional rectangles, interpreted views, 2—-10

Tile, menu selection, 2—20
Title bar, 2—-2
Toolbar, edit, 2—-3

U

Upper toolbar, 2—3
URL, Tektronix, vi

MTS300 Series Program Stream Analyzer

v

Version, software, v
Version number, v
Vertical lines, in rectangles, 2—8
View window, common elements, 2—4
Views
adding, 3-6
binary and hexadecimal, 2-10, 3—7
hierarchic, 2-5
interpreted, 2—7
multiplex rate, 3—7
pack header, 3-2
pack headers/packets map, 3—7
PES packet, 3—-3
program stream directory, 3-5
program stream map, 3—4
PTS/DTS, 3-10
SCR, 3-8

W

Web site address, Tektronix, vi
Window, application, 2-2
Windows
automatic analyses, 3-18
common elements, 2-4
error message, 3-14
Hierarchic view, 2-5
Interpreted view, 2—7

X

X, symbol, 2-5
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Artisan Technology Group is your source for quality
new and certified-used/pre-owned equipment

SERVICE CENTER REPAIRS WE BUY USED EQUIPMENT
Experienced engineers and technicians on staff Sell your excess, underutilized, and idle used equipment
at our full-service, in-house repair center We also offer credit for buy-backs and trade-ins

www.artisantg.com/WeBuyEquipment ”

lnstra%é«/”‘ REMOTE INSPECTION LOOKING FOR MORE INFORMATION?
Remotely inspect equipment before purchasing with Visit us on the web at www.artisantg.com 7~ for more
our interactive website at www.instraview.com ~ information on price quotations, drivers, technical

specifications, manuals, and documentation

Contact us: (888) 88-SOURCE | sales@artisantg.com | www.artisantg.com



